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1. Clinical Relevance and Summary of Test Principle 
  

In 1999, an estimated 415000 tons of conventional pesticides were applied in the United States.  
The most commonly used pesticide for home and garden was the herbicide 2, 4-D with an 
estimated use of 3000-4000 tons in those applications, giving an average domestic use per 
capita of ~ 15g/year.  During the same year, the most abundantly applied pesticide in U. S. 
agriculture was atrazine, with application of 35000 tons.  The widespread use of pesticides and 
the scientific interest in potential adverse health effect of pesticides exposure have increased 
the demand for fast and robust analytical methods for measuring markers of possible 
pesticides. 
 
This method assesses human exposure to select pesticide metabolites of non-persistent 
pesticides.  It does not directly test for any disease.  This method includes specific 
organophosphorous insecticide metabolites (5-chloro-1-isopropyl-[3H]=1, 2, 4-triazol-3-one; 
2-diethylamino-6-methyl pyrimidin-4-ol; 2-isopropyl-6-methyl-4-pyrimidiol; 3-chloro-4-methyl-
hydroxycoumarin; 2-[(dimethoxyphosphorothioyl) sulfanyl] succinic acid; 3, 5, 6-tricholor-2-
pyridinol; 4-nitrophenol, synthetic pyrethroids (3-[(1Z)-2-carboxyprop-1-en-1-yl]-2,2-
dimethylcyclopropanecarboxylic acid; 3-phenoxybenzoic acid; 4-fluoro-3-phenoxybenzoic acid; 
cis-3-(2,2-dichlorovinyl)-2,2-dimethyl-cyclopropane-1-carboxylic acid; trans-3-(2,2-dichlorovinyl)-
2,2-dimethyl-cyclopropane-1-carboxylic acid; trans-3-(2,2-dibromovinyl)-2,2-dimethyl-
cyclopropane-1-carboxylic acid), herbicides (Acetochlor mercapturate; alachlor mercapturate; 
atrazine mercapturate; metolachlor mercapturate; 2,4-dichlorophenoxyacetic acid; 2,4,5-
trichlorophenoxyacetic acid), and an insect repellant N, N-diethyl-m-toluamide (DEET).  The 
analytes are extracted and concentrated from the urine matrix using solid phase extraction 
cartridges, separated through high pressure liquid chromatography, and analyzed on a triple 
quadrupole mass spectrometer.   
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Table1. 

Analytes Measured, their Parent and Class Pesticides 
 

Analyte Parent Pesticide Pesticide Class 
2-isopropyl-4-methyl-pyrimidinol (IMPY) Diazinon Organophophorous 

Malathion dicarboxylic acid (MDA) Malathion Organophosphorous 

3-phenoxybenzoic acid (3-PBA) Permethrin, cypermethrin, 
cyfluthrin, others Pyrethroid 

Para-nitronphenol (PNP) Methyl parathion, 
parathion Organophosphorous 

5-chloro-1,2-dihydro-1-isopropyl-[3H]-1,2,4-
triazol-3-one (CIT) 

Isazaphos, isazaphos 
methyl Organophosphorous 

3-chloro-4-methyl-7-hydroxycoumarin 
(CMHC) Coumaphos Organophosphorous 

2-diethylamino-6-methyl pyrimidin-4-ol 
(DEAMPY) 

Pirimiphos methyl, 
pirimiphos Organophosphorous 

3,5,6-tricholor-2-pyridinol (TCPY) Chlorphrifos, chlorpyrifos 
methyl Organophosphorous 

2-[(dimethoxyphosphorothioyl) sulfanyl] 
succinic acid (CDCA)  Pyrethroid 

4-fluoro-3-phenoxy-benzoic acid (4F-3PBA) Cyfluthrin Pyrethroid 
Cis-dichlorovinyl-dimethylcyclopropane 

carboxylic acid (cis-DCCA) Permethrin, cypermethrin pyrethroid 

Trans-dichlorovinyl-dimethylcyclopropane 
carboxylic acid (trans-DCCA) Permethrin, cypermethrin Pyrethroid 

Cis-dibromovinyl-dimethylcyclopropane 
carboxylic acid (DBCA) Deltamethrin Pyrethroid 

N,N-diethyl-m-toluamide (DEET) DEET Insect Repellant 
2,4-dicholorphenoxyacetic acid (2,4-D) 2,4-D Herbicide 

2,4,5-tricholorphenoxyacetic acid (2,4,5-T) 2,4,5-T Herbicide 
Alachlor mercapturate (ALA) Alachlor Herbicide 
Atrazine mercapturate (ATZ) Atrazine Herbicide 

Metolachlor mercapturate (MET) Metolachlor Herbicide 
Acetochlor mercapturate (ACE) Acetochlor Herbicide 

 
2. Safety Precautions 
 

a. Reagent Toxicity or Carcinogenicity  
The reagents can be both toxic and carcinogenic.  Special care should be taken to 
avoid inhalation or dermal exposure to the acids and solvents necessary to carry 
out the procedure.    

 
b. Radioactive Hazards 

None 
 

c. Microbiological Hazards 
Although urine is generally regarded as less infectious than serum, the possibility 
of exposure to various microbiological hazards exists. Take appropriate measures 
to avoid contact with the specimen (see “Protective equipment” below). A hepatitis 
B vaccination series is usually recommended for health care and laboratory 
workers who are exposed to human fluids and tissues. Observe universal 
precautions. 
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d. Mechanical Hazards 

Following standard safety practice while performing this procedure minimizes the 
risk for mechanical hazards. Avoid any direct contact with the electronic 
components of the mass spectrometer unless all power to the instrument has been 
shut off. Only qualified technicians should perform electronic maintenance and 
repair. 

 
e. Protective Equipment 

Use standard personal protective equipment when performing this procedure. 
Wear a lab coat; safety glasses; and if appropriate, durable gloves. Use chemical 
fume hood for this procedure.  

 
f. Training 

Anyone performing this procedure must be trained and experienced in the use of a 
triple-quadrupole mass spectrometer. Formal training is not necessary; however, 
personnel should be trained appropriately by an experienced operator of the 
instrument.  

 
g. Personal Hygiene 

Be careful when handling any biological specimen. Use gloves and wash hands 
properly.  

 
h. Disposal of Wastes 

Always dispose of solvents and reagents in an appropriate container clearly 
marked for waste products, and temporarily store them in a flame-resistant cabinet 
(follow CDC’s  guidelines entitled Hazardous Chemical Waste Management) 
containers, glassware, etc., that come in direct contact with the specimens. 
Autoclave or decontaminate with 10% bleach. Wash the glassware and recycle or 
dispose it in an appropriate. Computerization; Data-System Management 

 
 
3. Computerization: Data-System Management 

 
a. Software and Knowledge Requirements 

A database named PSTARS was developed on the (DLS-PC) network using 
Microsoft Access. This database is used to store, retrieve, and analyze data from 
the pesticide-residue analyses. Perform statistical data analyses using Statistical 
Analysis System (SAS) ® software packages (or their equivalent) are required to 
use and maintain the data-management structure.  

 
b. Sample Information 

Electronically transfer or manually enter into the database information pertaining to 
particular specimens. If you manually enter data, include the sample-identification 
(ID) number, the notebook number associated with the sample preparation, the 
sample type, the standard number, and any other information not associated with 
the mass-spectral analysis. Electronically transfer the analytical information 



Universal Pesticides                          OAT-DLS 
DLS Method Code:  6103.01                                                                                            Page 4 of 32 
 

 

obtained from the sample to the database via a PC-based instrument interface. 
Then transfer the data electronically into the database.  

 
c. Data Maintanance 

See method 6112.01 for data handling, maintenance, and management 
procedures. 

 
4. Specimen Collection, Storage and Handling Procedures; Criteria for Specimen 
Rejection 
 

a. Sample Handling 
Urine can be collected in standard urine collection cups. Samples should be 
refrigerated as soon as possible and transferred to specimen vials within 4 hours 
of collection. If possible, collect at least 10-mL of urine and pour it into sterile vials 
(30-mL Qorpak ® vials with screw-caps tops are suggested). Label the specimens, 
freeze them to ≤-20 οC, and ship them on dry ice. Carefully pack vials to avoid 
breaks during shipment. Store all samples at ≤-20 οC until analysis.  

 
b. Sample Rejection 

Reject specimens with volumes less than 0.1-mL because they cannot be reliably 
processed.  

 
 
5. Procedures for Microscopic Examinations; Criteria for Rejecting Inadequately 
Prepared Slides 
 Not applicable for this procedure. 
 
6. Preparation of Reagents, Calibrators (Standards), Controls, and All Other Materials; 
Equipment and Instrumentation 

 
a. Reagents and Sources 

  Table 2. 
  Reagents and their Suggested Manufactures 

 
Reagents Suggested 

Manufacturers 
Acetonitrile Tedia Company Inc 
Acetone Tedia Company Inc 
Methanol Tedia Company Inc 
Glacial Acetic Acid JT Baker 

Deionized water NANOpure Infinity ultrapure water 
system 

Sodium Acetate Anachemia Chemicals NY 
Hexane Tedia Company Inc 
β-glucuronidase Sigma-Aldrich Co. 
Oxypyrimidine-methyl-4,5,6 Cambridge Isotope Labs 
Malathion Dicarboxylic Acid EPA-Pesticide Repository 
3-phenoxybenzoic acid Sigma-Aldrich 
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4-nitrophenol Sigma-Aldrich 
5-chloro-1,2-dihydro-1-isopropyl-
[3H]-1,2,4-trizaol-3-one Cambridge Isotope Labs 

3-chloro-4-methyl-7-
hydroxycoumarin Cambridge Isotope Labs 

2-diethylamino-6-methyl 
pyrimidin-4-ol Cambridge Isotope Labs 

3,5,6-trichloro-2-pyridinol Chem Service 
2-[(dimethoxyphosphorothioyl) 
sulfanyl] succinic acid Los Almos National Labs 

4-fluoro-3-phenoxy benzoic acid Aldrich 
Cis-dichlorovinyl-
dimethylcyclopropane carboxylic 
acid 

Cambridge Isotope Labs 

Trans-dichloro-dimethyl-
cyclopropane carboxylic acid Cambridge Isotope Labs 

Cis-dibromovinyl-
dimehtylcyclopropane carboxylic 
acid 

Cambridge Isotope Labs 

N,N-diethyl-m-toluamide Cambridge Isotope Labs 
2,4 Dichlorophenoxyacetic Acid Cambridge Isotope Labs 
2,4,5-trichlorophenoxyacetic 
acid Cambridge Isotope Labs 

Alachlor Mercapturate Cambridge Isotope Labs 
Atrazine Mercapturate Cambridge Isotope Labs 
Metolachlor mercapturate Cambridge Isotope Labs 
Acetochlor mercapturate Cambridge Isotope Labs 
Oxypyrimidine-methyl-4,5,6-13C4 Cambridge Isotope Labs 
D7 Malathion Dicarboxylic Acid Cambridge Isotope Labs 
Phenyl-13C6-3-phenoxybenzoic 
acid Cambridge Isotope Labs 
13C6-paranitrophenol Cambridge Isotope Labs 
13C6-5-chloro-1,2dihydro-1-
isopropyl-[3H]-1,2,4-triazol-3-
one 

Cambridge Isotope Labs 

13C6-3-chloro-4-methyl-7-
hydroxycoumarin Cambridge Isotope Labs 
13C6-2-diethylamino-6-methyl 
pyrimidin-4-ol Cambridge Isotope Labs 
13C5-15N-3,5,6-tricholor-2-
pyridinol Chem Service 
13C6 2,4-dicholorphenoxyacetic 
Acid Cambridge Isotope Labs 

2-[(dimethoxyphosphorothioyl) 
sulfanyl] succinic acid Los Almos National Labs 

D6-cis/trans-dichlorovinyl-
dimehtylcyclopropane carboxylic 
acid 1:1 

Ehrenstorfer 

Cis-dibromovinyl-dimehtylcyclopropane 
carboxylic acid Cambridge Isotope Labs 
13C6-N,N-diethyl-m-toluamide Cambridge Isotope Labs 
2,4-Dichlorophenoxyacetic-ring-
13C6

Cambridge Isotope Labs 
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13C6-2,4,5-
trichlorophenoxyacetic acid Cambridge Isotope Labs 

Alachlor acetylcysteine Adduct-
ring-13 C6

Cambridge Isotope Labs 

Atrazine Mercapturate-ring-13C3 Cambridge Isotope Labs 
Metolachlor Mercapturate-ring-13C6 Cambridge Isotope Labs 
Acetochlor Mercapturate-ring-
13C6

Cambridge Isotope Labs 

 
 
b. Reagent Preparation 

Liquid chromatography mobile phases:  
Mobile Phase A= 0.1% Acetic Acid in aqueous solution. For example, pipette 1 mL of 
Acetic Acid in 1000 mL in deionized water and mix. Mobile Phase B= 100% 
Acetonitrile.   
 
0.2 M Buffer Acetate Enzyme Solution: 
To hydrolyze possible glucoronide or sulfate conjugated metabolites in urine samples, 
β glucuronidase type H-1 from Helix pomatia (Sigma Chemical Co., St, Louis, MO).  To 
each sample an amount of enzyme giving 1000 units of activity dissolved in 1.5 mL of 
0.2 Acetate buffer.  For example, to prepare 1L of the buffer acetate, combine 9,7 g of 
sodium acetate, 3.1 mL of glacial acid acetic, and 1 l of deionized water.   

 
c. Standard Preparation 

1) Stock Solutions of Analytes (200 ng/mL) 
Individually weigh an appropriate amount of each analyte in a volumetric flask (for 
example 5 mg in a 25 mL flask). Add a few milliliters of acetonitrile to the flask and 
the swirl the flask to dissolve. Once the analytes are dissolved, dilute the contents of 
the flask to volume with acetonitrile and mix. Divide stock solutions into aliquots (for 
example, 10 mL) and place them in ampules or vials. If ampules are used, flame-
seal the ampules and store them at ≤-20 οC.  

 
2) Stock Solutions of Labeled Isotopes (200 ng/mL) 

Individually weigh an appropriate amount of each analyte in a volumetric flask. Add a 
few milliliters of acetonitrile to the flask and the swirl the flask. Once the analytes are 
dissolved, dilute the contents of the flask to volume with acetonitrile and mix. Divide 
stock solutions into aliquots (for example, 5-mL aliquots) and place them in ampules. 
Flame-seal the ampules and store them at ≤-20 οC.  
 

3) Working Labeled Isotopes Solution (ISTD) 
Make the working labeled stock isotopes solution by adding an aliquot of each of the 
stock solutions into a 50 mL volumetric flask and dilute contents of the flash with 
acetonitrile. Calculate concentration so that 50 µL aliquot of working solution in 2 mL 
of urine gives the concentration of 12 ppb (ng/mL).  
 

4) Working Standard Solutions 
Make nine solutions of varying concentrations ranging from 0.03 ppb to 8.0 ppb from 
the stock analyte solutions. Add an aliquot of the stock solutions of each analyte in 
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acetonitrile to make the standard. Calculate concentrations so that a 50 µL aliquot of 
working standard in 2 mL of urine gives the desired standard concentration (ranging 
from 0.39 to 100 ppb in urine) 

 
5) Calibration-Verification Materials 

CLIA defines testing calibration materials as “a solution which has a known amount 
of analyte weighed in or has a value determined by repetitive testing using a 
reference or definitive test method”.  According to this definition, our quality control 
(QC) materials qualify as calibration verification materials. 

 
6) Proficiency-Testing Standards (PT 1-3) 

Proficiency testing materials are matrix-based samples (typically spiked samples) 
with a known or characterized concentration.  These samples may be spiked or 
have endogenous levels of the target analytes. 

 
d. Equipment/Supplies 

1) TurboVap® LV evaporator (Zymark Corporation, Framingham, MA). 
2) Sartorius Ultramicro® Microbalance (Westbury, NY). 
3) 15-mL, conical tubes (Kimble Glass Inc). 
4) EDP2® pipettes (Rainin Instrument Co. Woburn, MA). 
5) Presterilized filter pipette tips (Rainin) 
6) Vacuum Box – Supelco Visiprep 24TM DL 
7) Vortex Genie® vortex mixer (Scientific Industries Inc., Springfield, MA). 
8) Qorpak bottles (Lab Depot, Inc., Cumming, GA). 
9) Vials with screw caps SN ST 23x85 (Durham) 
10)  OASIS® HLB 3cc Extraction Cartridges (Waters) 
11) Disposable Flow Control – Valve Linear for the Visiprep TM – LD (Supelco) 
12) Micro auto sampler vials with insert (Kimble Glass Inc) 
13) Compressed nitrogen, helium, and argon, liquid nitrogen (Holox  Ltd) 
 

e. Instrumentation 
The Finnigan TSQ Quantum, a high resolution triple-quadrupole mass spectrometer 
(ThermoFinnigan, San Jose, CA)  is equipped with a syringe pump, a divert/inject 
valve, an atmospheric pressure ionization (API) interface, a heated electrospray 
ionization (H-ESI) interface, and the Xcalibur data system.  Also, the TSQ quantum is 
connected to the Agilent 1100 Series LC System with a degasser, a quaternary pump 
and a heated column compartment and an autosampler. The entire system is 
controlled via ThermoFinnigan software Xcalibur. 

 
1)  Mass-Spectrometer TSQ Quantum 
• Interfaces used: atmospheric pressure ionization (APCI) and  heated electrospray 

ionization (H-ESI) 
• Scan mode: Selective reaction monitoring (SRM), product ion scan   
• The instrument needs to be calibrated and tuned every 3-6 months) for accurate 

results. Also after each calibration a gain check (tuning of the multiplier) is 
needed.  

• The instrument needs to be calibrated and tuned periodically for better 
applications. 
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• Table 4 shows an example of the optimized tuning parameters for the two 
instrument methods. 

• Table 5 shows the optimized precursor/product ion pairs as well as the collision 
off-set energy for the target compounds. 

 
Table 4. 

Tuning Parameters 
 

 

Table 5a 
Precursor/Product ion pairs and Collision off-set Energies for Positive Mode 
Analyte Precursor 

(m/z) 
Product 

(m/z) 
Collision  

Energy (V) 
IMPY-Q 153 84 26 
IMPY-C 153 70 27 
IMPY-L 157 88 26 

DEAMPY-Q 182 154 25 
DEAMPY-C 182 84 32 
DEAMPY-L 188 158 25 

CIT-Q 162 120 20 
CIT-C 164 122 20 
CIT-L 169 121 19 
ATZ-Q 343 214 27 
ATZ-C 343 172 37 
ATZ-L 346 217 27 
ALA-Q 365 162 27 
ALA-C 365 130 10 
ALA-L 371 168 27 
ACE-Q 351 130 10 
ACE-C 351 148 28 
ACE-L  357 130 10 

DEET-Q 192 119 26 
DEET-C 192 91 38 
DEET-L 198 91 38 

(“Q” = Quantification ion; “C” = Confirmation ion) 
                                          
 
 
 
 

MS Parameter Setting 

Ionization type APCI H-ESI 

Ion polarity mode Positive mode Negative mode 

Heated capillary 270º C 250º C 

Vaporizer temperature 450º C 150º C 

Sheath gas pressure 25 37 

Discharge current 4.0 4.5 

Aux Gas Pressure 5 10 

Collision gas Argon  at 1.5 mT Argon  at 1.5 mT 
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      Table 5b 
Precursor/Product ion pairs and Collision off-set Energies for Negative Mode 

 
Analyte Precursor 

(m/z) 
Product 

(m/z) 
Collision Energy 

(V) 
MDA-Q 273 141 16 
MDA-C 273 157 27 
MDA-L 280 147 16 

CDCA-Q 197 69 25 
CDCA-C 197 97 16 
CDCA-L 204 99 22 
PNP-Q 138 108 32 
PNP-C 138 92 32 
PNP-L 144 114 23 
MET-Q 409 280 22 
MET-C 409 150 35 
MET-L 415 286 22 

CMHC-Q 209 145 27 
CMHC-C 209 173 21 
CMHC-L 213 148 27 
2,4-D-Q 219 161 19 
2,4-D-C 221 163 19 
2,4-D-L 225 167 19 
TCPY-Q 196 196 7 
TCPY-C 198 198 7 
TCPY-L 202 202 7 

2,4,5-T-Q 253 195 21 
2,4,5-T-C 255 197 21 
2,4,5-T-L 261 203 21 

Cis &Trans_DCCA-Q 207 207 7 
Cis &Trans_DCCA-C 209 209 7 
Cis &Trans_DCCA-L 210 210 7 

4F-3-PBA-Q (1) 231 93 42 
4F-3-PBA-C (1) 231 187 19 

3-PBA-Q 213 93 42 
3-PBA-C 213 169 17 
3-PBA-L 219 99 42 
DBCA-Q 294 79 31 
DBCA-C 296 79 31 
DBCA-L 303 79 31 

(“Q” = Quantification ion; “C” = Confirmation ion) 
(1) 3-PBA-L was used as Internal Standard 

2) Agilent 1100 Series LC System 
Chromatographic separation is performed using an Agilent 1100 Series Capillary LC 
System composed of a Capillary Pump, Micro Vacuum Degasser, Thermostatted 
Micro Autosampler, and Thermostatted Column Compartment. 

 
7.  Calibration and Calibration-Verification Procedures 

 
a. Calibration Plot 

1) Construct a-point calibration plot by performing a linear regression analysis of 
relative response factor (i.e., area native/area label) versus standard concentration. 
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Perform a minimum of five repeat determinations are performed for each point on 
the standard curve.  

 
2) The lowest point on the calibration curve is at or below the measurable detection 

limits and highest point is above the expected range of results.  
 

3) Determine the slope and intercept of this curve is by linear least squares fit using 
SAS® software. 

 
4) R-squared values for the curve must be greater than 0.99. Linearity of standard 

curves should extend over the entire standard range. Intercepts, calculated from the 
least squares fit of the data, should not be significantly different from 0; if they are, 
identify the source of this bias.  

 
5) Periodically recalculate the standard curve to incorporate the newest data points. 

Whenever you prepare a new, combined, labeled-isotope solution, re-establish the 
standard curve. 

 
b. Verification of Calibration 

Calibration verification for the overall test system is performed by analyzing 
three concentrations of calibration verification materials (which are included in 
each run as QC materials) in the same manner as unknown samples. The 
concentrations span the useable range of the method but are weighted toward 
the expected unknown concentrations. The overall system is considered 
calibrated if the calculated concentrations are within ±3 standard deviations of 
the characterized mean values for each of the analytes measured in the 
method. Calibration verification of the overall test system is performed with 
every analytical run. No data are reported unless the overall test system passes 
calibration verification. Calibration results and any significant corrective actions 
are documented either in the PSTARS database or other ancillary documents. 
 
In addition, eight calibrators which span the linear range of the method are run 
with each analytical run which satisfies the requirements for calibration 
verification according to the Clinical Laboratory Improvements Amendments 
(CLIA) brochure #3 which states, “If the test system’s calibration procedure 
includes three or more levels of calibration materials, and includes a low, mid, 
and high value, and is performed at least once every six months, then the 
requirement for calibration verification is also met.”  

 
c. Proficiency Testing 

Proficiency testing should be performed a minimum of once every 6 months. 
Because no formal PT testing program exists for the target analytes of this 
method, an in-house program is used.  This in-house program currently includes 
pools prepared in-house or individually spiked but may also include 
independently prepared materials whose preparation was contracted out to an 
external laboratory.  Where applicable, NIST matrix-based certified reference 
materials may be included as PT materials. Five randomly selected PT 
materials will be analyzed in the same manner as unknown samples.  These PT 
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materials will be selected from among three different concentration ranges 
spanning the linear range of the method.  The concentration range for each 
sample will be blinded to all analysts.  The analytical results are evaluated by an 
auditor (e.g., branch statistician) who is independent of the laboratory 
performing the analyses.  A passing score is obtained if at least four of the five 
samples fall within the prescribed limits established by the auditor. The auditor 
will notify our laboratory of its PT status (i.e. pass/fail).  If a PT challenge is 
failed, a second attempt to demonstrate proficiency by analyzing a second set 
of PT samples is undertaken.  If the second attempt fails, laboratory operations 
will cease until an appropriate corrective action is taken.  After corrective action 
is taken, laboratory operations can resume.  

 
8. Operating Procedures; Calculations; Interpretation of Results  
 

a. Analytical Runs 
Allow the following to thaw and reach room temperature: unknown urine samples 
(usually 20), blank urine, three QC samples, and two blank urines used for standards. 

 
b. Sample Preparation 

Two mL of urine are pippetted into round bottom tubes with screw caps and spiked 
with 50 µl of the labeled internal standard stock solution. The urine samples are 
vortexed and to that mix 1.5 mL of acetate/β-glucaroindase buffer solution is added.  
The samples are then placed in an incubator at 37°C for at least 6 hours.  Samples are 
removed from incubator and allowed to come to room temperature.  Samples are run 
thru Oasis® 3cc cartridges that are conditioned with Acetone and 1% Acetic Acid in 
water solutions.  Cartridges are washed with 1.5 mL of a solution of 5% 1:5:94 Acetic 
Acid/MeOH/dH2O.  Cartridges are dried for 5 minutes.  Cartridges are then eluted with 
3.0mL of Acetone and 3.0mL of Hexane.    Samples are blown to dryness in 
TurboVap® LV evaporator (40°C, 10-12 psi).  Sample tubes are vortexed with 2.0mL 
Acetonitrile and blown to dryness and again with 0.5mL Acetonitrile.  Samples are 
finally reconstituted with 100 µl 1:1 ACN:water mixture.  Samples are stored in labeled 
HPLC autosampler vials and in a freezer if not analyzed immediately.   

 
c. Liquid Chromatography Conditions 

For analytes analyzed in negative H-ESI mode the chromatographic separation is done 
on a Betasil C-18, narrow-bore 4.6 x 100-mm, 3.0 µm (ThermoElectron Corporation) 
column using a gradient eluent program. The solvent used are; HPLC grade water with 
0.1% acetic acid in an aqueous solution (Solvent A) and acetonitrile (Solvent B). The 
gradient program follows as: t=0 min – 65% solvent A and 35% solvent B, t=3 min – 
60% solvent A and 40% solvent B, t=4 min – 55% solvent A and 45% solvent B, t=7 
min – 50% solvent A and 50% solvent B, t=9min – 35% solvent A and 65% solvent B, 
t=10 min – 25% solvent A and 75% solvent B, t=11min – 15% solvent A and 85% 
solvent B, t=12-13 min – 0% solvent A and 100% solvent B, and 3 min for equilibration 
at 65% solvent A and 35% solvent B before the next injection. The column used is a 
Betasil C-18, narrow-bore 4.6 x 100-mm, 5.0 µm (ThermoElectron Corporation). The 
analytes elute between 2 and 12 minutes. The run time for each analyte is 16.5 
minutes. The flow rate is 700 µl/min and the injection volume is 10 µl. The divert valve 
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is programmed to go to waste for the first two minutes and the last three minutes of the 
run. 

 

For analytes analyzed in positive APCI mode the chromatographic separation is done 
on an Aquasil C-18, narrow-bore 4.6 x 100-mm, 5.0 µm (ThermoElectron Corporation) 
column using a gradient eluent program. The solvent used are; HPLC grade water with 
0.1% acetic acid in an aqueous solution (Solvent A) and acetonitrile (Solvent B). The 
gradient program follows as: t=0 min – 75% solvent A and 25% solvent B, t=2 min – 
75% solvent A and 25% solvent B, t=2.5 min – 70% solvent A and 30% solvent B, t=3 
min – 65% solvent A and 35% solvent B, t=4min – 58% solvent A and 42% solvent B, 
t=5 min – 50% solvent A and 50% solvent B, t=6min – 42% solvent A and 58% solvent 
B, t=7 min – 32% solvent A and 68% solvent B, t=9 min – 32% solvent A and 68% 
solvent B, t=9.5-10.5min – 0% solvent A and 100% solvent B and 3 min for 
equilibration at 75% solvent A and 25% solvent B before the next injection. The column 
used is an Aquasil C-18, narrow-bore 4.6 x 100-mm, 5.0 µm (ThermoElectron 
Corporation). The analytes elute between 2 and 10 minutes. The run time for each 
analyte is 12.0 minutes. The flow rate is 750 µl/min and the injection volume is 10 µl. 
The divert valve is programmed to go to waste for the first two minutes and the last 
three minutes of the run. 
 

d. Mass Spectrometry Conditions 
 

1) Sequence Setup 
• Open Xcalibur -  Xcalibur allows to import data that has been created by 

Microsoft Excel. 
• To import a sequence: Choose File > Import Sequence to open the Import  

Sequence dialog box. 
• Use the Browse button to select the file for import.  
• In the select Columns to Import group box, select the sequence columns to be 

included in the sequence file. 
• Click on OK to import the sequence: Xcalibur displays the imported file in 

Sequence Setup. 
• Manually define the following parameters:  
• Path → Enter the directory path where the sample’s raw file will be stored;  
• Inst. Meth → Enter the path and filename of the instrument method file; and 
• Proc Method → Enter the path and filename of the processing method file. 
• For Save File: Choose File > Save AS. 

 
2) Autosampler 

On the Agilent 1100 Autosampler, place the vials into the sample tray, according the 
position on the sequence file.  The tray will hold 100 vials arranged in 10 rows of 10 
samples.   
The first vial position is 1 and the last position is 100. 
Ensure that the solvent reservoir contains sufficient running solvent for all the 
samples and that the solvent rinse reservoir contains enough of the rinse solvent 
(100% Acetonitrile) for a complete rinse.  
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3) Gases 
Ensure that there is enough N2 gas (utilized as the sheath and auxiliary gases) and 
argon (for the collision induced dissociation gas – CID). 

 
4) Run the sequence 

• In Tune Master, click on the On/Standby button on the Control/Scan Mode 
toolbar to turn on the mass spectrometer. 

• On the Control/Scan Mode toolbar, click on the AS/LC Direct Control Button to 
display the Inlet Direct Control view. 

• Set up the Agilent 1100 pump to deliver the initial condition of the instrument 
method you are about to run. 

• Let the instrument and pump system to be on conditioning for about 30 minutes 
before start running samples. Always run a standard check before running real 
samples.  

• Highlight the samples you want to run. Click on the left-most column of the first 
sample and drag to the last sample on the sequence.  

• Choose Actions > Run Sequence or click on the Run Sequence toolbar button. 
The Run Sequence dialog box is then displayed.  

• On the Sequence dialog box on the After Sequence Set System select 
(STANDBY) to put the instrument in standby mode and turn off the pump after 
the last sample has been analyzed. 

• Click on OK to start to analyzed the run.  
• Always run a probe wash and column wash program after the last sample in the 

sequence.   
 

e. Processing data 
• To process a batch of samples: 
• Select the rows to be processed from the current sequence → Click on the left-

most column of the first sample and drag to the last sample on the sequence. 
• Choose Actions>Bach Reprocess or click on the Bach Reprocess toolbar Button 

to display the Batch Reprocess Setup Dialog box. 
• Select the Quan check box and select the Peak Detection & Integration and 

Quantification boxes. 
• Click on OK. Xcalibur initiates batch reprocessing of the select samples.  

                   
f. Quantification 

• After processing the sample batch, manually evaluate for correct peak detection 
and baseline selection in the Quan® browser.  

• Export data files to EXCEL® using the long report format. 
• Quan Browser allows: to view quantitative results, to evaluate standard curve, 

QCs and unknowns samples, to integrate chromatogram peaks manually, and to 
analyze detailed quantification information.  

• To start Quan browser:  
• Click on the Quan Browser icon on the Home Page. 
• Quan Browser displays an Open dialog to select an exiting file (.SLD). 
• Xcalibur displays the View Sample Types dialog box that offers the following 

viewing options to choose:  
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• Show standard and QC samples types and Show All Samples types.  
• Click on OK to start the session. 
• Save the settings in a Quan Browser file (*.XQN). Choose File>Save As. 
• Export data files to EXCEL → File > Export Excel > Long Report.    
  

g. Rearrangement of Data Files 
Data are automatically rearranged into a single worksheet (Excel format)® that is 
compatible with our existing database using an Excel® macro. This macro also allows 
for analyst evaluation of quantification and confirmation ions.  

 
h. Transfer of Data 

Transfer the file to a mobile drive disk. 
 

i. Importation of Data into Database 
Select “Import new data” option in database.   A password is required to import the 
data. 

 
j. Statistical analysis and interpretation of data 

Export data from the database to a fixed ASCII file and import it into SAS®. SAS® 
programs for calibration plot generation, QC analysis, blank analysis, limit-of-detection 
(LOD) determination, unknown calculations, data distribution, etc., have been created 
and may be executed in SAS® when this information is needed. 

 
k. Routine and Periodic Maintenance of Key Components 

 
 1) Routine Maintenance 
 

a) Mass Spectrometer  
Flush the APCI/H-ESI probe at the end of each working day by flowing a wash 
(100% Acetonitrile), a probe-wash (50:50 methanol: water solution), and a 
condition (initial conditions-probe specific) from the LC through the APCI/H-ESI 
source. 

 
b) Agilent 1100 Autosampler 

The autosampler requires only a few simple maintenance procedures to keep    
 it in optimum working condition. 
 

• Checking the solvent tubing and connections for leaks 
• Clearing a plugged line or needle 
• Replacing column filter 
• Check needle position into vials. 

 
Ensure that the solvent reservoir contains sufficient running solvent for all 
samples and that the solvent rinse reservoir contains enough of the rinse solvent 
(100% Acetonitrile) for a complete rinse. 

 
c) Column, pre-filters and tubing   
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• Clean the column after each working day by flushing pure acetonitrile through it 
for at least 30 min at the flow rate were you normally operate. 

• Replacing pre column filter as needed 
 

 2) Periodic Maintenance 
In general, these maintenance procedures are performed if you detect a decrease in 
the system performance (sensitivity or S/N ratio) without any other apparent 
technical reasons. 

 
l. Calibration 

• Place the LC/MS System in Standby  
• Install the ESI Probe  

 
Use the following procedure to set up the syringe pump for introducing tuning and 
calibration solution into ESI source: 

• Install a sample transfer line between the syringe holder unit on the instrument 
and the sample inlet on the ESI probe.  

• Load a clean, 500 µL Hamilton® syringe with 420 µL of the polytyrosine-1, 3, 6 
tuning and calibration solution.  

• Insert the tip of the syringe needle into the end of the Teflon® tube on the syringe 
adapter assembly. Make sure to push the handle of the syringe holder down until 
it comes in contacts the syringe plunger. 

 
  Set up the mass spectrometer for tuning and calibration as follows: 

• In Quantum Tune Master, click on the On/Standby button on the Control/Scan 
Mode toolbar to turn on the mass spectrometer. (The Tune Master is 
automatically placed in the ESI source mode.) 

• Open the tune file called “posESI calibration parameters” (Capillary temperature 
2700C, Sheath gas pressure 5 psi, Auxiliary gas pressure 5 psi, spray voltage 
4.0 kV). Also make sure the mass spectrometer is put in positive ion mode. 

• Choose Setup>Syringe Pump & Sample Loop to set up the Syringe pump; 
specify flow rate (5-10 µL/min), syringe type (Unimetrics or Hamilton) and syringe 
size (10-500 µL).  

• Start off by monitoring the three dominant peeks that the polytyrosine-1, 3, 6 
tuning and calibration solution will produce in full scan mode by clicking on the 
Instrument Method Development Workspace button and select: Scan Type→ 
Full Scan; Scan Mode→ Q1MS; Scan Range/Entry Mode → FM/LM; enter First 
mass → 150 and Last mass → 1050; PeakWidth/Q1 box → enter 0.70; Scan 
time enter 0.70; Tack the Data Processing box → Average. Confirm AutoSIM 
box is not selected and that Micro Scans is set to 1 and Accurate Mass Mode is 
OFF. Click Apply. 

• Three dominant peeks m/z 182.082 (polytyrosine monomer), 508.2080 
(polytyrosine trimer) and 997.3980 (polytyrosine hexamer) should now be visible. 
Make sure that these three really are the dominant peaks in their m/z range. Do 
not continue unless they are. Use a new calibration solution if needed. 

• Click on the Creep toolbar button to normalize the spectrum. The Y-axle will now 
show relative intensities. Also make sure that the intensities are in their 106- 107. 
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Establish a stable ion beam: 
• Zoom in to look at mass m/z 508.2080. Click on the Instrument Method 

Development Workspace button Select: Scan Type→ Full Scan; Scan Mode→ 
Q1MS; Scan Range/Entry Mode → Center Mass; enter Center mass → 508.208 
and Scan With → 10.000; PeakWidth/Q1 box → enter 0.70; Scan time enter 
0.20; Tack the Data Processing box → Average. Confirm AutoSIM box is not 
selected and Micro Scans is set to 1 and Accurate Mass Mode is OFF. Click 
Apply. 

• Click on the Creep toolbar button to normalize the spectrum. Look at the m/z 508 
peek and make sure it does not change more than 30% in intensity from scan to 
scan. Also make sure that the peek is nicely gauss shaped not split in the top. 
These are indications of whether the ion beam produce are stable or not. 

 
Dealing with an unstable ion beam:     
• Adjust the sheath and/or auxiliary gas pressure. 
• Move the ESI needle tip closer or further away from the capillary transfer tube 

opening. (There are knobs on the ion max source housing to move the needle tip 
in x- and y-axis.) 

  
 When establishing a stable ion beam: 

• Click on System Tune and Calibration Workspace button and select Auto Tune-
Calibration (to specify a full tune and calibration) and Both (to tune and calibrate 
in both Q1 and Q3).      

• Click on Start to start the automatic calibration. 
 
When tune and calibration has completed successfully  
• Click on Accept (if calibration went through), and then Save Calib. As (to save 

the created tune and the calibration files). Finally click on Print (to print the data 
from the calibration). 

• Click on Gain to perform a tuning of the multiplier. When gain check has been 
completed successfully, add these new settings into the calibration file just 
created. In Quantum Tune Master save under File>Save Calibration As>. 

• Finnish calibration by flushing tubing and probe with a (50:50) solution of HPLC- 
grade methanol and water.  

 
a) Creating Tuning Files in ESI, H-ESI, and APCI mode.    

• Place the LC/MS System in Standby  
• Install the appropriate probe  
• Install a T-connection so mobile phase from the LC-pump and liquid from the 

syringe can be mixed up before entering the probe.  
• Open the Quantum Tune Master. 
• Turn on the Instrument on the On/Standby button and the Control/Scan Mode 

toolbar 
• Turn on the LC pump and let it run at the operating flow rate. (Acetonitrile:water 

50:50).   
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• Fill the syringe with the compound (10-20 ng/μL desolved in acetonitrile) of 
interest (the compound the tuning file is going to be based up on) and put the 
flow to 10μL/min.  

• Click on the Define Scan Button in Tune Master. Zoom in on the parent mass.  
 
Click on the Optimize Compound Dependent Devises button on the Control/Scan Mode 
toolbar to display the Compound dependent parameters 

• Spray Voltage (ESI/H-ESI)  
• Discharge Current (APCI)  
• Sheath Gas Pressure  
• Aux Valve Flow 
• Vaporizer Temperature (APCI/H-ESI) 
• Capillary Temperature 
• Tube Lens Offset  
• Source CID  
• Collision Pressure   
• Collision Energy  
• Quad MS/MS Bias 

 
Check one or several at a time (or all of them at the same time) and hit the Start button 
and the software will to find the optimum settings for the compound of interest. When 
the tuning has completed successfully: click on Accept and then Save As to save the 
tuning file.  

  
 
b) Maintaining the APCI probe 

The APCI probe requires a minimum of maintenance.  
 

              Remove the APCI Nozzle: 
• Place the instrument in Standby mode 
• Hold onto the APCI probe body with one hand and grasp the head of the APCI 

nozzle assembly.  
• Rotate the head of the nozzle assembly until the Flat sides of the head are facing 

towards the retention flanges. The Nozzle assembly is now free of the probe. 
• Carefully pull the nozzle assembly straight out of the APCI probe. 
• Place the assembly on a clean, lint free tissue. 
• Cleaning the APCI probe components: 
• Check the condition O-rings on the APCI nozzle. 
• Clean the interior APCI components (excluding the ceramic heater) with a 50:50 

solution of HPLC-grade methanol and distilled/deionized water and a lint-free 
swab.  

 
              Removing the APCI Sample Tube: 

• With a 3/8-in. open-end wrench, remove the sample tube inlet fitting 
 (P/N 70005-20250), 0.239-in. ID O-ring (P/N 00107-04000), and  
 sample tube from the APCI manifold. 

• Remove the exit-end nut (P/N 70005-20220), 0.016-in. ID, PEEK  
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Ferrule (P/N 00101-18120), and sample tube from the sample tube  
inlet fitting. 

• Discard the old sample tube. 
 

c)  Housing Maintenance 
The Ion Max ion source housing is designed to be serviced by trained Service 
Engineers only. User maintenance is limited to cleaning the ion source housing as 
necessary. To clean the housing, remove the housing from the instrument and in an 
appropriate fume hood, rinse the interior of the housing with methanol and allow to 
dry before installing on the instrument. 

 
9. Reportable Range of Results 
 

The linear range of the standard calibration curves determines the highest and lowest 
analytical values of an analyte that are reportable. The calibration verification of the 
method encompasses this reportable range. However, you can dilute and re-analyze 
urine samples whose analytical data values exceeds the highest reportable limit so that 
the result will be in the reportable range.  

 
a.  Linear Limits 

Analytical standard were linear for all analytes through the range of concentrations 
evaluated. The linear range for all analytes was LOD to 100 ppb. Resample urine 
samples whose concentrations exceed these ranges, and re-analyze them using a 
smaller aliquot.  
 

b.  Analytical Sensitivity 
The detection limits (LODs) for all analytes were calculated as 3S0, where S0 is the 
standard deviation (SD) at zero concentration and is determined by linear regression 
analysis of the absolute standard deviation (SD) versus concentration. The detection 
limits vary based upon the current operating precision and the cleanliness of the 
analytical system. The range of detection limits determined to date for the analytes are 
presented in Table 8. 

 
Table 8.  

Analyte Detection Limits 
 

Analyte 3S0 
ng/ml 

IMPY_Q 0.06 
CIT_Q 0.18 

DEAMPY_Q 0.06 
ATZ_Q 0.51 
ACE_Q 0.18 
ALA_Q 0.36 

DEET_Q 0.06 
MDA-Q 0.05 

CDCA-Q 0.21 
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PNP-Q 0.10 
MET-Q 0.10 

CMHC-Q 0.18 
2,4-D-Q 0.10 
TCPY-Q 0.18 
2,4,5-T-Q 0.10 
DCCA-Q 0.30 

4F-3-PBA-Q 0.12 
3-PBA-Q 0.20 
DBCA-Q 0.30 

 
c. Accuracy 

The accuracy of this method was determined by enriching urine samples with know 
concentrations of the pesticides residues and comparing the calculated and expected 
concentrations. The accuracy was consistent across the entire linear range. The 
accuracy can be expressed as the slope of a linear regression analysis of the expected 
value versus the calculated value. A slope of 1.0 indicates that the results are identical.  
Another way of expressing a method’s accuracy is as a percentage of the expected 
value.  

Table 9.  
Accuracy of the Method 

 
Analyte Slope  

(Calculated vs. 
Expected) 

IMPY_Q 0.9998 
CIT_Q 0.9997 

DEAMPY_Q 0.9996 
ATZ_Q 0.9996 
ACE_Q 1.0294 
ALA_Q 1.0330 

DEET_Q 1.0000 
MDA-Q 0.999 

CDCA-Q 0.999 
PNP-Q 0.999 
MET-Q 0.999 

CMHC-Q 0.998 
2,4-D-Q 0.998 
TCPY-Q 0.999 
2,4,5-T-Q 0.999 
DCCA-Q 0.997 

4F-3-PBA-Q 0.999 
3-PBA-Q 0.999 
DBCA-Q 0.961 
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d. Precision 
The precision of this method is reflected in the variance of (QC) samples over time. The 
major contributor to the overall calibration verification is the variation between runs. 
Variation and the total coefficient of variation were determined from multiple analyses of 
quality control materials throughout the study. The total calibration verifications of the 
method vary from study to study and are dependent upon instrument, operators, and 
sample preparation analyst. The calibration verifications shown in Table 10 are 
representative of the most recent study.  

 
Table 10. 

Precision of the Method 
 

QCL QCM QCH 
Analyte 
(ppb) 

Con 
ng/ 
mL 

Stdv CV 
 (%) 

Con 
ng/ mL Stdv CV 

 (%) 
Con 

ng/ mL Stdv CV 
 (%) 

IMPY_Q 1.2 0.1 14 8.6 0.9 11 16.5 1.8 11 
CIT_Q 1.1 0.2 16 8.4 1.1 13 16.5 2.8 17 

DEAMPY_Q 1.1 0.1 11 8.6 1.1 12 16.7 2.3 14 
ATZ_Q 1.3 0.2 18 10.2 1.3 13 18.9 2.6 14 
ACE_Q 1.4 0.2 14 10.6 1.1 10 19.4 2.3 12 
ALA_Q 1.4 0.2 15 10.6 1.2 11 19.2 2.1 11 

DEET_Q 1.3 0.2 12 8.8 0.9 10 16.7 2.0 12 
MDA-Q 1.7 0.2 15 13.6 1.1 8 25.2 2.0 8 

CDCA-Q 2.2 0.4 18 10.4 0.8 7 18.3 1.4 8 
PNP-Q 1.1 0.1 11 8.3 0.7 8 15.4 1.3 8 
MET-Q 1.2 0.1 9 9.9 0.8 8 18.8 1.7 9 

CMHC-Q 1.2 0.1 17 7.8 1.2 15 16.0 1.1 7 
2,4-D-Q 1.2 0.1 11 10.2 0.9 9 18.8 1.5 8 
TCPY-Q 1.2 0.2 14 9.0 0.9 11 16.6 1.5 9 
2,4,5-T-Q 1.2 0.1 8 9.4 0.8 8 18.1 1.4 8 

Trans-DCCA-Q 1.2 0.2 18 8.6 1.0 12 16.8 2.2 13 
Cis-DCCA-Q 1.4 0.2 14 8.7 0.7 8 16.0 2.0 12 
4F-3-PBA-Q 1.1 0.1 10 8.9 0.7 8 16.2 1.2 8 

3-PBA-Q 1.1 0.2 15 8.7 0.8 9 16.5 1.4 9 
DBCA-Q 1.1 0.2 17 8.9 1.0 11 16.5 1.3 8 

    
  Con = Average Concentration             

Stdv= Standard deviation of the QC Values 
CV= coefficient of variation of the QC Values 

 
 

e. Analytical Specificity 
This is a highly selective method that requires the following of each analyte detected: 1) 
that it be at a specific retention time, 2) that it has two precursor ions at specific masses, 
3) that it has two specific product ions formed from each of the two precursor ions at 
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specific masses, and 4) that the ion ratios of the two product ions be within a 
predetermined range. 

 
10. Quality Control (QC) Procedures 
 

a. QC Materials 
Urine pools enriched with known amounts of pesticide residues as the control materials 
used for each unknown run.  
 

b. Collection of Urine for QC Pools 
Prepare and use three QC pools in each run of unknown samples. Collect the urine and 
screen the urine to ensure that the endogenous levels of pesticide residues are low or 
non-detectable. Combine and homogenize the urines samples to form a base pool.  

 
c. Urine Enrichment 

Split the base pool equally into four smaller urine pools. Reserve one pool for blank and 
standard analyses (see “Sample Preparation” section). Enrich one of the pools with an 
appropriate amount of the stock solution of each pesticide residue to yield an 
approximate concentration of 0.5 µg/L (QCL). Enrich the other pool to yield an 
approximate concentration of 5 µg/L (QCM) Enrich the final pool with an appropriate 
amount of each pesticide stock solution to yield an approximate concentration of     
15 µg/L (QCH).  

 
d. Filtration and Dispensing 

Clean filter each pool to 0.2 µ. Dispense the urine in 12-mL aliquots into 25-mL, sterile, 
screw-capped vials. Label the vials appropriately, and then freeze the QC materials at -
20°C until needed.  

 
e. Characterization of QC Materials 

Characterize the QC pools (including the unspiked pool) by 20 consecutive runs of each 
QC material. Use the data from these runs to establish the mean and upper-and lower- 
99th and 95th confidence intervals. Determine the confidence intervals and adjust them 
according to the number of each QC material analyzed in each run.  

 
f. Use of QC Samples  

During each analytical run, analyze one blank urine and three QC materials: QCL, 
QCM, QCH. 

 
g. Final Evaluation of Quality Control Results 

Evaluate QC material are evaluated using standard Westgard multirule criteria 
(www.westgard.com).  Repeat out-of-control runs if residual sample is available.   No 
data from runs considered out-of-control will be reported. 

 
11. Remedial Action If Calibration or QC Systems Fail to Meet Acceptable Criteria 
 

If the calibration or QC systems fail to meet acceptable criteria, suspend all operations 
until you identify the source or cause of failure is identified and corrected. If the source of 
failure, for example, failure of the mass spectrometer or a pipetting error, correct the 

http://www.westgard.com/
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problem immediately. Otherwise, prepare fresh reagents and clean the mass 
spectrometer system. Before beginning another analytical run, re-analyze several QC 
materials (in the case of QC failure) or calibration-verification samples (in the case of 
calibration failure). After re-establishing calibration or QC, resume analytical runs.  

 
12. Limitations of Method; Interfering Substances and Conditions 
 

This method is an isotope-dilution mass spectrometry method, which is widely regarded 
as the definitive method for the measurement of organic toxicants in human body fluids. 
By using high-resolution tandem mass spectrometry, you can eliminate most analytical 
interferences. Because of the matrix used in this procedure, occasional interfering, 
unknown substances have been encountered. Interferences with the internal standards 
result in rejection of that analysis. If repeat analysis still results in an interference with the 
internal standard do not report the results for that analyte. 

 
 13. Critical-Call Results (“Panic Values”) 
 

It is unlikely that any result would be a “critical call,” which would only occur with 
poisonings. Report test results in this laboratory in support of epidemiological studies, 
rather than clinical assessments. Data will help determine critical exposures.  
 

14. Specimen Storage and Handling during Testing 
 

Refrigerate urine samples overnight to expedite thawing prior to aliquoting the sample. 
Store the urine extracts in autosampler vials in a -20°C freezer after analysis. Stability 
studies suggest that the extracts remain stable at room temperature for up to 5 days.  

 
15. Alternate Methods for Performing Test and Storing Specimens If Test System Fails 
 

The method is designed to run on a LC/MS/MS instrument and is not generally 
transferable to other instrumentation. If the system has failed, store sample vials may in 
a refrigerator. You can store the extract samples for as long as 3 weeks. If you 
anticipate long-term interruption, store samples between -80°C and -20°C.  

 
16. Test-Result Reporting System; Protocol for Reporting Critical Calls (If Applicable) 
 

Once the validity of the data has been established by the QC/Quality Assurance system 
outlined above and has been verified by a DLS QAO, generate one hard copy and one 
electronic copy of the data. Route these data, a cover letter, and a table of method 
specifications and reference range values through the appropriate channels for approval 
(i.e., supervisor, branch chief, division director). Once division personnel have approved, 
the information, send it to the contact person who requested the analyses. 
 
Report data in support of epidemiological or health survey studies. At this time there is 
not protocol for reporting critical calls.  
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17. Transfer or Referral of Specimens; Procedures for Specimen Accountability and 
Tracking 
 

Use standard record-keeping systems (i.e., notebooks, sample logs, data files, creatinine 
logs, demographic logs) to keep track of all specimens. Transfer of refer to CLIA-
specimens only certified laboratories. Any transfer of study samples is handled through 
the DLS special studies coordinator. 
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19. Notes 
 

1. Special care should be taken to avoid loss of sample when thawing because cracks 
may occur in the sample containers.  It is recommended to put samples in refrigerator 
over night so that samples thaw slowly.   
 

2. QC limits and means may vary over time as additional studies are completed and their 
QC data are added in the characterization. 
 

3. Method specifications, including LOD and CV, are calculated for individual study, so 
may vary slightly. 

 
4. The analytical detection limits and QC limits may vary from study to study as more 
data are available for statistical calculations.  QC limits do not vary within studies, but 
remain constant.  
  

5. The expiration time for the standard working solutions is determined by monitoring the 
peak intensity for each standard over time in the analytical runs. 

 
6. The expiration time for the Quality Control material is determined by monitoring the 
concentration of each QC over time in the analytical runs. 

 
7. The frequency of cleaning the components of the mass spectrometer depends on the 
types and amounts of samples and solvents that are introduced into the instrument. 
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20. Appendix I “Robustness Test” 

 
Introduction 

The robustness of an analytical method is an estimation of its capability to remain 
unaffected by small but deliberate changes in method variables. It provides a qualitative 
estimation of reliability when analyses are performed in standard conditions.  The 
robustness test performed on this method includes: 

 

  a. Sample Stability after Preparation. 

b. Solid Phase Extraction without Condition and Equilibration Steps. 

c. Solid Phase Extraction without Wash Step. 

d. Re-inject Repeatability.  

e. TurboVap Evaporator Temperature. 

 

(a) Sample Stability after Preparation. 
 Test Description 
 The stability of Universal Pesticides stored in urine extract for extended periods was 

evaluated. The sample stability preparation time was determined at two concentrations, 
around 10 ppb and 20 ppb.  Five runs consistent of five QC medium samples, five QC high 
samples, and a standard series were prepared the same day. Runs were combined and 
thoroughly mixed to ensure homogeneity.  The combined runs were subsequently aliquoted 
into four runs.  One run was analyzed the same day and the other three runs were stored at 
-10 οC and analyzed during different days (see Table 1). Average measured concentration 
values from each day were compared with the averaged measured concentration values 
from the first day. 

  

 Results/Discussion 

 In the “delayed injection” test, all mean values measured on subsequent days after the 
first day were within 10% of the mean values on the first day (see Table1).   The highest 
percent of deviation for sample stability after preparation was found for TCPY_Q (8%) 
between days 8 and 1. 

 

(b) Solid Phase Extraction (SPE) without Conditioning and Equilibration Steps. 
    

 Test Description 
 A major cause of poor recovery in SPE stems from the need to pre-wet traditional 

reversed-phase sorbents with a water-miscible organic solvent and keeping them wetted 
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before applying the aqueous sample matrix.  If the sorbent dries out before loading the 
sample, retention of the analytes falls sharply.  Then the capacity is severely compromised, 
and sample breakthrough can be significant.Polymeric solid phase extraction cartridges 
such as Oasis HLB ® are designed to simplify and improve the sample preparation by 
combining the right sorbent chemistry, device format and methodology. They incorporate a 
hydrophilic-lipophilic-balanced water-wettable copolymer optimal for any sample cleanup.  
Oasis HLB® cartridges are unique in their purity, reproducibility, stability, and retention 
characteristics. The water wettable capability of these OASIS cartridges was evaluated by 
comparing two sets of five QC mediums and five QC high with and without conditioning and 
equilibration steps.  

 Results/Discussion 

 In the “Solid Phase Extraction without conditioning and equilibration steps” test, all 
mean values were measured and compared with the mean values for the regular clean up 
procedure.  All the results from the procedure without the conditioning and equilibration 
steps were within 10% of the mean values of the procedure that included the conditioning 
and equilibration steps (see Table2).   The highest percent of deviation for the solid phase 
extraction with and without conditioning and equilibration steps was found for ALA_Q 
(12.5%).  By using these polymeric solid phase cartridges, we can expect robust SPE 
methods without having to endure irreproducible results and low recoveries caused by 
undesirable silanol activity, sorbent drying, pH limitations, and breakthrough of polar 
compounds/metabolites.   

 (c) Solid Phase Extraction without Wash Step. 

 Test Description 

 The possible wash effects in the solid phase extraction procedure were evaluated by 
preparing two sets of five QC mediums, five QC highs, and a calibration curve.  One of the 
sets was prepared excluding the wash step during the sample clean up and the other set 
was prepared following the regular clean up procedure.  Both sets were prepared and 
injected the same day. 

Results/Discussion 

 In the “Solid Phase Extraction without wash step” test, all mean values from extraction 
without wash step were measured and compared with the mean values for regular clean up 
procedure.  All the results from the procedure without wash step were within 10% of the 
mean values of the procedure that included the wash step (see Table3).   The highest 
percent of deviation for solid phase extraction with and without wash step was found for 
Cis_DDCA_Q (8%).   
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(d) Re-inject Repeatability.  
  
 Test Description 
 To investigate effects on precision and accuracy caused by repetitively injecting and 

analytical run, a set of 6 QC mediums, 6 QC highs, and a completed calibration curve was 
prepared using the regular sample clean up.  Samples were analyzed the same day that 
they were prepared.  Then, samples were recapped and stored a -10 οC overnight.  The next 
day, samples were removing from the refrigerator and allowing them to reach room 
temperature before been re-injected into the HPLC-MS/MS system.  The injection vials were 
recapped and stored at – 10 οC for the next four (4) days. Finally, samples were removing 
from the refrigerator and allowing them to reach room temperature before been re-injected 
for the third time into the HPLC-MS/MS system.  Mean values from the second and fifth 
injections were compared to mean values from the first injection.  The accuracy of the 
second and fifth day injections were expressed as percentage deviations from the mean 
values obtained the first day. 

 
 Results/Discussion 
 In the “Re-inject repeatability” test, all mean values measured on subsequent days 

after the first day were within 10% of the mean values on the first day (see Table 4).   The 
highest percent of deviation for re-inject repeatability was found for CIT_Q and DEAMPY_Q 
(9.7%) between days 5 and 1. 

 

(e) Turbo_Vap Evaporator Temperature. 
 
 Test Description 
 
 Thermal stability of the analytes during the sample clean up was evaluated by 

preparing three different sets of six QC mediums, six QC highs and a calibration curve under 
different turbo-vap temperatures (30 οC; 40 οC, and 50 οC).  Average measured 
concentration values from each temperature (40 οC, and 50 οC) were compared with the 
averaged measured concentration values from the regular temperature (30 οC).  All three 
sets were prepared and injected the same day. 

 

 Results/Discussion 
 In the “Turbo_vap” test, all mean values measured at 40 οC, and 50 οC were within 

15% of the mean values on the regular procedure at 30 οC (see Table 5).   The highest 
percent of deviation turbo-vap temperature was found for MDA_Q (10.2%) between samples 
clean up at 50 οC and samples clean up at 30 οC 
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Table 1.   Data from robustness test, “Sample Stability after Preparation”. Mean 
concentrations of QCs (mediums and high levels) and a comparison of the percent 
deviations of these values.  The absolute percent deviations are calculated by comparing 
each day’s mean values to the mean values of the first day such as  % Dev (1) comparing 
day 2 versus day 1; % Dev (2) comparing day 4 versus day 1, and % Dev (3) comparing day 
8 versus day 1. (n=5) 

Aver Std Aver Std Aver Std Aver Std
QCM 12.4 0.2 12.2 0.5 12.8 0.8 12.2 0.1 1.6 3.2 1.9
QCH 22.6 1.4 22.5 1.6 23.6 0.8 22.1 0.5 0.6 4.4 2.2
QCM 9.9 0.2 9.1 0.7 9.4 0.2 9.9 0.1 7.7 5.0 0.6
QCH 18.1 0.5 18.2 1.7 17.3 0.6 17.2 1.1 0.5 4.8 5.2
QCM 8.1 0.1 8.0 0.9 8.4 0.9 8.1 0.5 1.2 3.4 0.8
QCH 15.6 0.4 15.5 1.0 15.3 0.7 15.0 1.0 0.8 2.4 3.9
QCM 8.1 0.1 8.0 1.2 7.7 0.8 8.2 0.5 1.4 4.7 1.2
QCH 15.8 1.0 15.6 0.3 15.7 0.7 15.6 1.1 1.6 0.7 1.8
QCM 9.7 0.3 10.0 0.8 10.0 0.2 9.6 0.4 3.3 3.9 0.7
QCH 19.1 0.7 19.9 1.2 20.1 0.6 20.4 1.0 4.2 4.9 6.4
QCM 10.6 0.7 10.6 1.8 10.4 0.2 9.9 0.7 0.1 1.9 6.0
QCH 18.8 1.8 19.3 0.4 19.8 0.2 18.8 1.3 2.8 5.4 0.0
QCM 8.9 0.2 9.0 0.4 8.8 0.9 8.7 0.2 1.3 0.7 2.4
QCH 16.7 0.6 15.9 0.2 15.8 0.4 15.4 1.0 5.1 5.5 8.0
QCM 9.9 0.3 9.9 0.5 9.3 0.7 9.4 0.5 0.2 6.1 5.3
QCH 19.4 0.5 19.0 1.2 19.1 0.4 19.0 0.7 1.8 1.2 1.8
QCM 8.0 0.1 8.2 1.1 8.2 0.6 8.1 0.6 2.9 2.6 0.7
QCH 16.1 0.8 15.8 0.5 16.3 0.9 15.8 1.2 2.3 1.0 1.8
QCM 9.0 0.2 9.2 1.6 9.0 0.6 9.1 0.7 2.3 0.8 1.3
QCH 16.4 0.6 16.4 0.5 16.4 0.8 16.1 0.8 0.4 0.3 2.1
QCM 8.9 0.5 8.7 0.1 8.4 0.4 8.7 0.7 2.1 5.0 2.0
QCH 16.3 1.6 15.1 0.9 15.6 1.1 15.7 0.8 7.0 4.4 3.3
QCM 8.4 0.1 8.2 0.9 8.0 0.5 8.1 0.4 2.3 4.8 4.0
QCH 15.4 0.8 15.0 0.6 15.2 0.5 15.3 0.9 2.7 1.6 0.5
QCM 7.8 0.2 8.3 1.0 7.7 0.1 8.0 0.5 5.8 2.2 2.6
QCH 15.6 0.9 15.4 0.7 15.3 0.2 15.2 0.9 1.4 2.1 2.7
QCM 9.2 0.2 8.5 0.2 8.8 0.6 8.6 0.7 8.0 4.8 6.9
QCH 17.1 0.5 16.2 0.1 16.1 0.5 15.9 0.8 5.2 5.7 6.8
QCM 8.8 0.1 8.5 0.2 8.6 0.3 8.4 0.4 3.5 2.4 4.7
QCH 17.2 0.2 16.1 0.3 16.3 0.7 16.1 0.7 6.7 5.4 6.6
QCM 9.0 0.1 9.1 0.6 8.9 0.3 8.7 0.3 1.1 0.4 2.6
QCH 17.8 0.3 16.8 0.9 16.7 1.0 16.5 1.0 5.8 6.4 7.5
QCM 10.5 0.3 10.4 0.3 10.1 0.6 9.9 0.6 0.3 3.5 5.4
QCH 19.6 0.4 19.0 0.5 19.1 0.7 18.9 0.7 3.2 2.7 3.8
QCM 10.9 0.1 10.6 0.3 10.6 0.2 10.4 0.3 2.3 3.0 4.8
QCH 20.6 0.3 19.9 0.8 19.3 0.5 19.1 0.8 3.5 6.1 7.1
QCM 10.8 0.2 10.8 0.2 10.7 0.2 10.5 0.2 0.1 0.8 2.7
QCH 19.4 0.6 19.0 0.5 19.4 0.5 19.2 0.5 2.1 0.1 1.0
QCM 8.9 0.4 8.6 0.2 8.4 0.4 8.2 0.2 3.1 5.3 7.6
QCH 17.0 0.3 16.6 0.8 17.1 1.0 16.9 0.8 2.5 0.3 0.9

%Dev (1) %Dev (2) %Dev (3)

DEET_Q

DEAMPY_Q

ATZ_Q

ACE_Q

ALA_Q

IMPY_Q

CIT_Q

MDA_Q

CDCA_Q

PNP_Q

CMHC_Q

DBCA_Q

MET_Q

2,4 D_Q

TCPY_Q

2, 4, 5 T _Q

4 Day 8 Day

Cis DDCA_Q

Trans DDCA_Q

2 Day
Sample_Name

1 Day
Analyte

3 PBA_Q

4F-3 PBA_Q
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Table 2.   Data from robustness test, “Solid Phase Extraction without Condition and 
Equilibration Steps”. Mean concentrations of QCs (mediums and high levels) and a 
comparison of the percent deviations of these values.  The absolute percent deviations are 
calculated by comparing set mean values from procedure without condition and equilibration 
steps to the set mean values from procedure with condition and equilibration steps. (n=5). 

Aver Std Aver Std
QCM 14.2 0.3 14.8 0.3 4.0
QCH 27.5 0.9 26.9 0.8 2.3
QCM 10.0 0.5 10.2 0.2 2.8
QCH 18.0 0.9 18.7 0.2 3.8
QCM 9.0 0.3 8.7 0.2 3.6
QCH 16.5 1.3 16.6 0.3 0.3
QCM 7.9 0.2 8.6 0.2 8.9
QCH 16.8 0.9 17.0 0.6 1.0
QCM 9.9 0.3 9.9 0.4 0.5
QCH 20.6 1.7 19.6 0.9 4.9
QCM 10.4 0.4 10.1 0.4 3.5
QCH 20.2 0.8 19.5 0.4 3.3
QCM 9.9 0.4 9.4 0.1 5.0
QCH 18.6 0.9 17.6 0.3 5.3
QCM 9.5 0.5 9.6 0.5 0.5
QCH 19.0 0.7 18.7 0.6 1.4
QCM 9.3 0.1 9.3 0.2 0.3
QCH 17.9 0.5 17.7 0.2 1.1
QCM 8.4 0.3 9.1 0.5 8.3
QCH 17.0 0.7 17.2 0.5 1.0
QCM 9.6 0.9 8.9 0.3 6.6
QCH 16.4 0.6 16.9 0.4 3.0
QCM 9.2 0.3 9.1 0.4 0.7
QCH 15.9 1.0 15.7 0.7 1.7
QCM 9.3 0.5 9.0 0.5 3.1
QCH 16.8 0.3 17.5 0.4 4.2
QCM 8.2 0.5 8.9 0.5 8.1
QCH 16.1 0.9 17.2 0.9 6.9
QCM 8.0 0.4 7.8 0.4 2.0
QCH 15.5 0.6 15.6 0.6 0.9
QCM 7.4 0.5 8.0 0.5 7.4
QCH 17.1 1.1 17.6 1.1 2.9
QCM 10.6 0.5 10.4 0.5 1.5
QCH 19.0 1.3 20.3 1.3 6.9
QCM 10.5 0.8 10.0 0.8 4.6
QCH 19.3 0.9 19.5 0.9 0.9
QCM 9.6 0.3 10.8 0.3 12.6
QCH 18.8 1.1 19.7 1.1 5.2
QCM 8.1 0.6 8.5 0.6 5.0
QCH 17.7 1.2 16.9 1.2 4.7

%Dev (1)Analyte Sample_Name
C&E for SFE_C No C&E for SFE_C

CMHC_Q

PNP_Q

CDCA_Q

MDA_Q

2, 4, 5 T _Q

TCPY_Q

2,4 D_Q

MET_Q

Cis DDCA_Q

Trans DDCA_Q

4F-3 PBA_Q

3 PBA_Q

DBCA_Q

DEAMPY_Q

CIT_Q

IMPY_Q

DEET_Q

ALA_Q

ACE_Q

ATZ_Q
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Table 3.   Data from robustness test, “Solid Phase Extraction without Wash Step”. Mean 
concentrations of QCs (mediums and high levels) and a comparison of the percent 
deviations of these values.  The absolute percent deviations are calculated by comparing set 
mean values from procedure without wash step to the set mean values from procedure with 
wash step. (n=5). 

Aver Std Aver Std
QCM 12.3 1.3 12.3 2.1 0.0
QCH 23.0 2.7 22.4 3.9 2.6
QCM 10.1 0.3 10.1 1.2 0.0
QCH 22.2 1.9 22.0 1.6 0.7
QCM 8.8 0.8 8.5 0.6 2.6
QCH 18.5 1.8 18.0 1.6 2.9
QCM 9.6 0.9 10.0 1.6 4.0
QCH 19.5 1.2 18.7 1.2 4.1
QCM 10.5 1.2 10.0 1.4 5.3
QCH 19.5 1.6 19.1 1.5 1.9
QCM 10.3 0.8 10.1 0.8 2.6
QCH 20.1 2.0 20.6 0.9 2.1
QCM 9.7 1.1 9.8 1.1 1.6
QCH 20.1 2.7 20.2 1.9 0.2
QCM 9.7 0.5 9.3 0.9 4.3
QCH 19.5 1.9 19.4 1.6 0.2
QCM 9.3 1.0 9.1 0.9 2.5
QCH 19.3 0.9 18.9 1.0 2.4
QCM 7.5 0.4 7.7 0.3 2.1
QCH 19.2 0.4 19.1 1.1 0.3
QCM 9.1 0.7 9.4 0.9 3.9
QCH 19.5 1.3 20.0 2.7 2.6
QCM 9.5 0.8 8.9 0.7 6.5
QCH 17.7 1.8 17.8 2.1 0.7
QCM 9.7 0.8 9.0 0.7 8.0
QCH 17.8 1.8 17.9 2.1 0.4
QCM 9.1 0.5 8.9 0.3 2.9
QCH 19.8 3.3 19.4 2.2 1.7
QCM 9.7 1.2 10.3 0.8 5.7
QCH 20.6 2.3 20.3 3.0 1.2
QCM 9.3 0.7 9.6 1.2 2.7
QCH 21.2 1.3 19.8 1.7 6.7
QCM 10.2 0.7 10.8 1.1 5.4
QCH 20.1 1.0 20.8 0.7 3.5
QCM 10.1 0.6 10.5 0.3 3.6
QCH 20.7 2.5 20.5 0.6 1.0
QCM 10.4 0.7 10.7 0.6 3.5
QCH 19.8 0.7 20.8 1.3 4.7
QCM 10.0 0.7 10.4 0.6 4.7
QCH 20.1 1.0 20.7 1.2 2.6

%Dev (1)Analyte Sample_Name
With Wash Step Withouth Wash Step

MDA_Q

CDCA_Q

PNP_Q

CMHC_Q

MET_Q

2,4 D_Q

TCPY_Q

2, 4, 5 T _Q

3 PBA_Q

4F-3 PBA_Q

Trans DDCA_Q

Cis DDCA_Q

DBCA_Q

IMPY_Q

CIT_Q

DEAMPY_Q

ATZ_Q

ACE_Q

ALA_Q

DEET_Q
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Table 4.   Data from robustness test, “Re-inject Repeatability”. Mean concentrations of 
QCs (mediums and high levels)  and a comparison of the percent deviations of these values.  
The absolute percent deviations are calculated by comparing each days mean values to the 
mean values of the first day such as  % Dev (1) comparing day 2 versus day 1; % Dev (2) 
comparing day 5 versus day 1. (n=6). 

Aver Std Aver Std Aver Std
QCM 14.2 0.3 14.8 0.3 13.9 0.3 4.7 1.8
QCH 27.1 0.7 26.2 0.4 26.2 0.4 3.4 3.5
QCM 10.3 0.2 10.3 0.3 10.7 0.1 0.5 4.3
QCH 18.7 0.2 18.0 1.0 18.4 1.2 3.9 1.7
QCM 8.7 0.1 8.9 0.3 8.3 0.2 1.6 5.0
QCH 16.7 0.3 15.7 0.4 15.7 0.4 5.7 5.8
QCM 8.7 0.1 9.4 0.2 8.9 0.2 7.6 2.1
QCH 17.2 0.3 17.0 0.9 16.7 1.0 1.0 2.7
QCM 9.8 0.1 10.3 0.2 9.7 0.1 5.2 1.0
QCH 19.1 0.2 18.3 0.7 18.0 0.8 3.9 5.7
QCM 10.2 0.1 11.0 0.2 9.6 0.2 7.1 6.4
QCH 19.5 0.4 19.2 0.7 18.0 0.9 1.5 7.8
QCM 9.5 0.1 9.2 0.2 8.9 0.1 3.1 6.1
QCH 17.6 0.3 17.6 0.7 16.1 0.8 0.3 8.6
QCM 9.7 0.1 10.5 0.2 9.5 0.1 7.8 2.6
QCH 18.9 0.2 19.2 0.7 18.0 0.9 1.5 4.9
QCM 9.2 0.1 9.6 0.3 8.9 0.2 4.6 3.1
QCH 17.7 0.3 17.4 0.7 16.0 0.8 1.8 9.6
QCM 9.4 0.1 9.8 0.2 8.7 0.1 4.4 7.1
QCH 16.4 0.4 16.9 0.6 15.9 0.7 3.3 2.8
QCM 8.9 0.4 8.8 0.4 8.4 0.4 0.9 6.1
QCH 16.9 0.4 16.5 0.4 16.4 0.3 2.1 2.5
QCM 9.1 0.4 9.2 0.1 9.2 0.1 1.9 1.2
QCH 17.6 0.6 16.3 0.6 16.3 0.6 7.2 7.4
QCM 9.1 0.4 9.5 0.3 8.8 0.3 3.9 3.6
QCH 17.6 0.3 16.8 0.3 16.3 0.3 4.2 7.5
QCM 9.2 0.2 8.6 0.2 8.5 0.1 6.8 8.0
QCH 17.1 0.5 16.2 0.6 16.2 0.7 4.9 5.2
QCM 9.0 0.1 9.0 0.1 8.5 0.1 0.1 4.9
QCH 17.8 0.3 16.7 0.6 16.1 0.7 6.0 9.7
QCM 9.0 0.1 9.0 0.1 8.5 0.1 0.1 4.9
QCH 17.8 0.3 16.7 0.6 16.1 0.7 6.0 9.7
QCM 10.5 0.3 10.1 0.3 9.6 0.2 3.4 8.0
QCH 19.6 0.4 20.0 0.3 19.0 0.4 1.7 3.3
QCM 10.5 0.1 10.9 0.2 10.0 0.3 3.6 4.6
QCH 20.2 0.3 20.0 0.4 19.4 0.4 0.8 3.7
QCM 10.3 0.2 11.0 0.2 10.2 0.2 6.1 1.7
QCH 19.0 0.6 19.9 0.7 17.8 0.7 4.7 6.2
QCM 8.8 0.0 9.4 0.1 8.4 0.1 6.7 4.4
QCH 16.9 0.3 16.9 0.7 15.9 0.7 0.1 6.4

2 Day

MET_Q

2,4 D_Q

TCPY_Q

5 Day

MDA_Q

CDCA_Q

PNP_Q

Analyte Sample_Name
1 Day

IMPY_Q

%Dev (1) %Dev (2)

Cis DDCA_Q

DBCA_Q

2, 4, 5 T _Q

3 PBA_Q

4F-3 PBA_Q

Trans DDCA_Q

CMHC_Q

ALA_Q

DEET_Q

CIT_Q

DEAMPY_Q

ATZ_Q

ACE_Q
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Table 5.   Data from robustness test, “Turbo_Vap Temperatures”. Mean concentrations of 
QCs (mediums and high levels) and a comparison of the percent deviations of these values.  
The absolute percent deviations are calculated by comparing each temperature condition 
mean values to the mean values of the regular clean up at 30 οC.  (n=6). 

Aver Std Aver Std Aver Std
QCM 12.5 0.7 11.3 1.1 11.9 1.7 10.2 5.0
QCH 23.5 1.0 22.7 1.6 21.8 1.2 3.7 7.5
QCM 8.3 0.4 8.0 0.5 7.7 0.9 2.6 7.2
QCH 15.4 0.9 15.1 0.5 14.9 1.6 2.3 3.3
QCM 8.0 0.4 7.8 0.9 7.7 1.1 2.1 3.2
QCH 14.5 1.2 14.3 1.2 15.4 2.3 1.3 6.2
QCM 7.9 0.8 8.0 0.9 8.0 0.6 1.6 2.0
QCH 15.4 0.8 16.0 0.8 15.5 1.7 3.8 0.4
QCM 8.6 0.4 8.4 0.5 7.8 0.8 2.2 9.3
QCH 17.9 0.6 17.6 0.9 18.0 2.2 2.0 0.3
QCM 8.6 0.7 8.0 0.3 7.9 0.8 6.0 8.3
QCH 18.3 1.2 18.0 0.8 18.3 1.0 1.4 0.1
QCM 8.1 0.4 7.7 0.7 8.1 1.1 4.1 0.4
QCH 17.4 1.1 17.3 0.9 17.3 2.1 0.7 0.8
QCM 8.7 0.8 8.5 0.9 8.9 0.6 2.7 2.2
QCH 17.6 0.9 16.8 0.9 17.7 0.9 4.5 0.5
QCM 7.3 0.3 7.4 0.7 7.8 0.9 2.0 7.4
QCH 15.5 1.3 15.1 1.6 15.7 0.9 2.6 1.6
QCM 8.4 0.9 8.1 0.9 8.2 0.6 3.6 2.2
QCH 17.2 1.5 17.3 1.3 17.0 1.1 0.1 1.6
QCM 7.2 0.8 7.4 0.6 7.2 0.8 2.8 0.7
QCH 15.0 1.3 15.0 0.9 15.2 1.0 0.1 1.2
QCM 7.7 0.8 7.7 0.8 7.9 0.3 1.0 2.0
QCH 17.5 1.0 16.4 0.8 17.4 0.7 6.2 0.7
QCM 6.7 0.7 7.0 1.5 6.9 0.8 4.1 2.6
QCH 16.0 1.1 15.8 0.7 15.9 1.2 1.3 0.8
QCM 8.2 0.4 7.6 0.8 8.2 0.7 7.4 0.9
QCH 16.9 1.3 16.9 1.4 16.9 1.5 0.4 0.3
QCM 7.8 0.5 8.0 0.3 8.0 0.7 2.2 2.4
QCH 19.1 1.1 19.4 0.9 19.7 0.7 1.4 3.1
QCM 8.4 1.2 7.7 0.9 8.7 1.2 7.7 3.3
QCH 18.6 0.7 18.7 0.6 18.8 1.0 0.7 1.0
QCM 10.0 1.0 9.6 1.0 9.0 0.6 4.2 9.8
QCH 18.4 0.7 18.8 0.4 18.7 0.6 2.2 1.7
QCM 10.5 1.3 9.8 0.9 9.6 1.3 6.0 8.3
QCH 18.3 0.7 18.7 0.5 18.7 1.1 1.9 2.0
QCM 9.6 0.7 9.5 0.8 9.3 0.5 1.3 3.9
QCH 18.9 0.5 19.1 0.4 19.1 0.9 0.7 1.0
QCM 9.1 0.6 8.7 0.5 9.1 0.5 5.2 0.0
QCH 18.0 0.7 17.4 1.1 17.9 0.8 2.9 0.3

%Dev (1) %Dev (2)Analyte Sample_Name
30 οC 40 οC

2,4 D_Q

TCPY_Q

2, 4, 5 T _Q

MDA_Q

CDCA_Q

PNP_Q

CMHC_Q

ALA_Q

DEET_Q

IMPY_Q

CIT_Q

DEAMPY_Q

50 οC

ATZ_Q

ACE_Q

DBCA_Q

3 PBA_Q

4F-3 PBA_Q

Trans DDCA_Q

Cis DDCA_Q

MET_Q
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